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Chapter 1  

Introduction 

This guide is designed as a companion guide to the Sitecore CMS Performance Guide. It 
provides you with a series of diagnostic procedures that can help you identify 
performance issues, as well as a means to measure performance gains through tuning. 

This manual contains the following chapters: 

 Chapter 1 —Introduction 

 Chapter 2 — Diagnostic Procedures 
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Chapter 2  

Diagnostic Procedures 

Diagnostic procedures are a series of tests that help identify performance issues in a 
Sitecore implementation. 

The procedures defined are complimentary to the CMS tuning. By running the diagnostic 
procedures before and after tuning the Sitecore CMS, performance improvements can be 
recorded. 

This chapter contains the following sections: 

 Browser Page Test 

 Investigating Page Performance (using the IIS Logs) 

 Rendering Performance 

 Investigating Memory Leaks with the Sitecore Logs 
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2.1 Browser Page Test 

"The size of the average web page of the top 500 websites has more than quintupled since 2003. From 
2003 to 2009 the average web page grew from 93.7K to over 507K (see Figure 1), over 5.4 times larger 
(Domenech et al. 2007, Flinn & Betcher 2008, Charzinsk 2010). During the same six-year period, the 
number of objects in the average web page more than doubled from 25.7 to 64.7 objects per page. 
Longer term statistics show that since 1995 the size of the average web page has increased by 35 times, 
and the number of objects per page has grown by 28 times." - 
http://www.websiteoptimization.com/speed/tweak/average-web-page/ 

What the previous statement means, is that in today's webpages it is crucial to understand the number 
and size of objects that are loaded into a webpage. Also, how a web server is setup to cache objects and 
minimize the number of requests that are made is important. 

There is a lot of information that can be gathered by analyzing what takes place when a webpage is 
loaded into a browser. Information about what is being requested, time to response, size of objects, and 
so on is available. Also how the server is setup in terms of caching, compression, CDN usage, and keep-
alive information can be viewed. 

This task looks at using an open source plug-in, AOL Pagetest, along with how to interpret the results. 

2.1.1 Setup 

The AOL Pagetest browser plug-in can be downloaded from: 
http://sourceforge.net/projects/pagetest/files/ 

Once it has been downloaded, install in its default location. The AOL Pagetest plug-in works with IE 7+ 
browsers, and appears in the Tools menu.  

Note 
If IE was opened during the installation, you must restart IE for the AOL Pagetest to appear in the Tools 
menu. 

2.1.2 How to Use the AOL Pagetest Browser Plug-in 

To launch AOL Pagetest: 

1. Launch IE. 

http://www.websiteoptimization.com/speed/tweak/average-web-page/
http://sourceforge.net/projects/pagetest/files/
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2. In the Tools menu, click AOL Pagetest .  

 

2.1.3 Capturing Information 

There are 3 useful page loading scenarios that are gathered during this exercise to see how the webpage 
reacts to a cleared browser cache, a webpage reload, and a webpage request with a loaded cache. 

 Cleared browser cache — this simulates the first time a page is visited from the browser being 
used. 

o To clear the browser cache for IE 8 and above: 

o In the Safety menu, click Delete browsing history... 

o Clear Preserve Favorites website data, and select Temporary Internet Files, Cookies, 
and History. 

 To clear the browser cache for IE 7: 

o In the Tools menu, click Internet Options 

o Under Browsing History, click Delete... 

o To delete your cache, click Delete files... 

o Click Close, OK. 

 Webpage reload or refresh — This forces requests to be made to objects in cache, resulting in 
304 status codes. When a 304 status appears, a request is still made for an object, even though 
no download occurs. 

 Accessing a recently visited webpage (typing in the URL) — This results in a page with a much 
reduced request chain, since items that were previously loaded into the browser cache are 
accessed without making any requests. 

First Pass — Cleared Browser Cache 

1. Launch IE. 

2. Clear the browser cache (see above). 

3. Launch AOL Pagetest. 
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4. Type in the URL you wish to test (for example: http://www.sitecore.net). 

5. The AOL Pagetest window now contains 4 tabs (Waterfall, Checklist, Optimization Report, and 
Load Details). The following section explains how to interpret the information presented in each 
tab. 

A view of the 4 tabs: 

 

Observations: 

 Notice that the Waterfall tab shows a full request made to each object in the webpage. 

 That assets such as CSS and JS files have not been combined, so multiple requests are being 
made to download them. By combining all of your CSS and JS files, the time line is pushed to the 
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left, due to a single request being made, shortening the time to render the page. 
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Second Pass - Refresh Browser Page 

1. In the AOL Pagetest File menu, click New 

2. Refresh the browser page — click refresh page, or press F5. 
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3. View the results in the Waterfall tab, and compare to the results from the first pass. 

 

Observations: 

 The objects highlighted in yellow are 30x status codes.   

 The results show that cached items are requested, but not downloaded.  This is expected 
behavior for a page that has been refreshed.   

 What can be taken from this view is that those items with a 304 status code should not be 
requested during the 3rd pass, "A recently visited page". 

Third Pass — Recently Visited Webpage 

1. In the AOL Pagetest File menu, click New. 

2. In the browser select the URL and hit enter (do not click the browser’s refresh button). 
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3. View the results in the Waterfall tab, and compare to the results from the first and second 
passes. 

 

Observations: 

 The request tree has been reduced significantly. 

 It is known that the first two requests, / and visitor.css, are dynamic and not cached. 

 The third item requires investigation as to why it is not coming from cache. Upon further 
investigation it was found that this request is a rotating image, which changes across visits. (OK 
not to be in cache). 

2.1.4 Interpreting the Results 

Here we dive into the Waterfall, Checklist, Optimization Report, and Load Details tabs, explaining the 
information that is presented. 

Waterfall Tab 

The Waterfall tab presents a view of the request chain that makes up the requested objects for a web 
page. The requested objects are listed down the left side, and the time is listed along the top. 

The colors that make up a request / response are: 

 

 DNS Lookup — This is the time it takes to look up the IP Address for the requested URL. 

 Initial Connection — This is the time that it takes to go from the client to the server to open up a 
socket. Note, if an initial connection is made on every request, this could be an indication that the 
HTTP keep-alive has not been enabled on the server. 
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 Time to First Byte — This is the time that it takes from request to receiving the first byte of the 
object. Extended Time to First Byte times could be an indicator of a problem at the server (for 
example, performance issues), or network issues. 

 Content Download — This is the time required to download an object. Extended Content 
Download times could be an indicator of large objects. An inspection of the size of the object may 
be required. For example: images that have not been optimized or compressed could have an 
effect on the performance of the web page. 

 Start Render — This is the green vertical line shown on the Waterfall. This indicates when the 
user starts to see content appear in the browser. Technically this represents the time when the 
web page has a height and width > 0. 

 Document Complete — This is the time when the document complete event had fired. 

 3xx Result — Objects that are highlighted in yellow indicate that 3xx status code has occurred, 
such as a request or cache request. 

 4xx Result — Objects that are highlighted in red indicate that a 4xx status, or error code has 
occurred. These should be investigated ASAP. 

Checklist Tab 

The Checklist tab is a report card of how well your site takes advantage of performance related settings 
and procedures. 

Topics are listed from left to right in order of importance: 

 A green check mark indicates a pass. 

 A yellow triangle indicates a warning. 
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 A red X indicates a "failure" 

 

The following table contains information about the meaning of each topic, what objects they apply to, as 
well as what is checked: 

 
Cache Static Applicable Objects Any non-html object with a mime type of "text/*", "*javascript*" 

or "image/*" that does not explicitly have an Expires header of 0 
or -1, a cache-control header of "private", "no-store" or "no-
cache" or a pragma header of "no-cache" 

What is checked An "Expires" header is present (and is not 0 or -1) or a "cache-
control: max-age" directive is present and set for an hour or 
greater. If the expiration is set for less than 30 days you get a 
warning (only applies to max-age currently).  

Use A CDN Applicable Objects All static non-html content (css, js and images) 

What is checked Checked to see if it is hosted on a known CDN (CNAME 
mapped to a known CDN network). The known CDN's are 
Akamai, Amazon CloudFront, Coral Cache, Edgecast, Google, 
Highwinds, Internap, Limelight, Mirror Image, Panther and 
Yahoo 

Combine CSS/JS Applicable Objects All css and javascript objects 

What is checked If multiple files of the same type are served then each 
additional css file beyond 1 subtracts 5 percent and each 
Javascript file beyond the first subtracts 10 percent 

GZIP Text Applicable Objects All objects with a mime type of "text/*" or "*javascript*" 

What is checked Transfer-encoding is checked to see if it is gzip. If it is not then 
the file is compressed and the percentage of compression is 
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the result (so a page that can save 30% of the size of it's text 
by compressing would yield a 70% test result) 

Compress 
Images 

Applicable Objects Any object with a mime type of "image/*" 

What is checked GIF - All pass 
PNG - Must be 8 bit or lower (no 24-bit PNGs pass) 
JPEG - Within 10% of a photoshop quality 50 pass, up to 50% 
larger warns and anything larger than that fails. 
The overall score is the percentage of image bytes that can be 
saved by re-compressing the images.  

Keep-Alive Applicable Objects All objects that are from a domain that serves more than one 
object for the page — for example, if only a single object is 
served from a given domain it is not checked. 

What is checked The response header contains a "keep-alive" directive or the 
same socket was used for more than one object from the given 
host 

Cookies Applicable Objects All requests 

What is checked Any request for a static object that sends up a cookie fails. All 
other requests that send up cookies warn. 

Minify JS Applicable Objects All html, javascript and json responses 

What is checked Javascript is run through jsmin. If the original content was gzip 
encoded, the minified version is also gzipped for comparison. If 
> 5KB or 10% is saved then it fails. If > 1KB is saved, it warns, 
otherwise it passes. 

No Etags Applicable Objects All requests 

What is checked If the response headers include an ETag header then the 
request fails. 

Information to Solving Failures and Warnings: 

 Failures in the Cache Statics column indicate that the HTTP Expires Web content header is not 
set, refer to: IIS Expire Web Content Header. 

 Warnings in the Cache Statics column indicate that the HTTP Expires Web content header has a 
value set to less than 30 days. Refer to: IIS Expire Web Content Header. 

 Failures in the Combine CSS /JS column indicate that CSS and or JS files are not combined into 
fewer files, indicating that multiple requests are being made to pull in these objects. 

 Failures in the GZIP text column indicate that static compression is not enabled on the web 
server. Refer to: Enable IIS Static Content Compression. 

 Failures in the Keep-Alive column indicate that HTTP keep-alive is not enabled on the web 
server, causing a connection having to be initiated for every object requested. Refer to: Enable 
IIS HTTP keep-alive. 

Optimization Report Tab 

The Optimization Report tab provides general information related to load times for the page, as well as 
where improvements can be made (based on the topics in the Checklist tab). In some cases, such as 
compression settings, an estimate of how much savings in terms of size is provided. 

The Optimization Report tab is a textual view of what is presented in both the Waterfall and Checklist 
tabs.  
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Load Details Tab 

The Load Details tab is a detailed account of what happens with every request. This information is useful 
for narrowing down issues with a particular request. 
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2.2 Investigating Page Performance (using the IIS Logs) 

This Investigating Page Performance Task is designed to find pages that take longer than 4000 ms (4 
sec) round trip, using the IIS logs. The results are recorded and used as a starting point for further 
investigation into which rendering component, or components, may be the culprit leading to poor 
performance. 

The advantage of parsing information from the IIS logs vs. measuring page performance directly is that 
you also are able to look at geo-location information (possible network issues that occur due to location), 
and issues that may occur during peak usage (indicators of capacity problems). 

2.2.1 Required Skills 

 A working knowledge of Log Parser. 

 A working knowledge of the IIS Logs. 

2.2.2 Symptoms 

 Slow page round trip times. 

2.2.3 Talk to the Partner / Customer 

The first step in determining where problem / slow loading pages exist is to ask the partner / customer / 
website owner if they are aware of any pages that appear to be slow. Record the URIs for further 
investigation into what is causing the performance issues.  

Also, find out what are the peak run times for the web site. This information is used to determine if the 
web site has the capacity to handle load during peak usage. 

2.2.4 Procedure to Query IIS Logs for Long Running Requests 

Information about installing the Log Parser can be found at http://www.microsoft.com/en-
us/download/details.aspx?id=24659 

This query looks at the requested URLs ordered by time required to process the requests in descending 
order. This allows you focus on a rendering, or set of renderings in which to investigate. 

Note that we are removing any URLs that include /sitecore/ to avoid looking at Sitecore client tools traffic. 

To query the IIS Logs, looking for long running requests: 

1. Launch the command line in a directory where the Log Parser is installed. 

2. Run the following command (change the #logs location# and #output file#): 

logparser –i:IISW3C –o:CSV 

 

"SELECT TO_TIMESTAMP(date, time) as [Timestamp], cs-uri-stem as [URI], c-ip AS [Client IP], time-

taken as [Time], sc-status as [Status]    

INTO #output file# 

FROM #logs location# 

WHERE ((EXTRACT_EXTENSION(URI) = 'aspx' OR EXTRACT_EXTENSION(URI) = '') AND URI NOT LIKE 

'%/sitecore%')  

AND time-taken > 4000 

AND Status = '200' 

ORDER BY time-taken DESC" 

 

http://www.microsoft.com/en-us/download/details.aspx?id=24659
http://www.microsoft.com/en-us/download/details.aspx?id=24659
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2.2.5 Understanding the Results 

Open the output file in Excel and look at the results in two parts. The first is a series of long running 
requests that are all coming from the same client IP address. For this purpose you can use sorting or 
filtering functionality in Excel. This could be an indication of in-house testing. Or could show the IP 
addresses with the slow or limited bandwidth. The second is a more typical set of results coming from 
external traffic to the site. 

Results Part 1 

 

To check to see where the Client IP address is geo-located, go to http://ip2location.com/1.2.3.4, where 
1.2.3.4 is replaced with the client IP address. For example, http://ip2location.com/195.184.101.130 would 
yield (note: this is also useful for tracking down possible network issues based on location): 
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Results Part 2 

 

After identifying URIs that either result from testing efforts or possible network issues due to geo-location,  
record the remaining. 

If there is a wide spread number of URIs that are above the threshold, in our case 4 seconds, that occur 
during peak operation could be an indicator of a web site that does not have enough capacity to handle 
the load 

2.2.6 Sitecore Recommendation 

Sitecore recommends that the round trip time for any given .aspx page be under 4 seconds. 
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Report Findings 

Record the Results 

The peak hours of usage for the web site are: _______________________________________ 

Record any URIs that have a round trip time of greater than 4 seconds. These URLs are used during the 
Analyze Rendering Components task.  

 

Timestamp URI Client IP Status Code Time 

     

     

     

     

     

There are requests have exceeded the 4 second threshold __ YES __ NO 

There is a large number of different URLs during peak operation hours __ YES __ NO. 

 

There are requests that have exceeded the 4 second threshold = NO 

 

OK. There are no request round trips that exceed 4 seconds.  

 

There are requests that have exceeded the 4 second threshold = YES 

 

Error. There are request round trips that have exceeded 4 seconds. Further investigation is required. 
Refer to the Rendering Component Performance Task. 

 

There is a large number of different URLs during peak usage hours = YES 

 

Error. There is a large number of different URIs that have exceed the 4 second threshold during peak 
usage hours. This could be an indication of capacity problems and requires further investigation.  
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2.3 Rendering Performance 

By using the Sitecore stats page, information about rendering can be collected.  

The stats page provides the following information about the various rendering used in a page, or 
throughout the site (depending when the stats page is observed). 

 Rendering — The name of the rendering. 

 Site — The name of the site that the information for the rendering is being collected. 

 Count — The number of times that the rendering has been called since the last time the stats 
page was reset. 

 From cache — The number of times the rendering was pulled from cache. 

 Avg. time (ms) — The average time taken to render to output. 

 Avg. items — The average number of items included in the rendering. 

 Max. time — The maximum amount of time taken to render the output. 

 Max. items — The maximum number of items included in the rendering. 

 Total time — The total amount of time taken for all instances of this rendering since the last stats 
page reset occurred. 

 Total items — The total number of items included in all instances of this rendering since the last 
stats page reset occurred. 

 Last run — This the last time that stats were collected. 

2.3.1 Required Skills 

 A working knowledge of the Sitecore stats.aspx page. 

2.3.2 Symptoms 

 Slow webpage round trip times. 

2.3.3 Procedure to Use the Sitecore Stats Page 

This procedure requires that you have permissions to access aspx pages in the /sitecore/admin folder. 
Also, we recommended that the stats page be opened up in a separate tab or browser window, so that 
you can keep it open while using another tab or window to navigate the site you are investigating. 

To launch the stats page: 

1. Launch either two web browser windows or tabs. We refer to these as the stats window and the 
site window. 

2. In the stats window, go to http://<site>/sitecore/admin/stats.aspx. 

3. The stats window shows information about the renderings that have been requested since the 
last time the stats page was reset. If you want to start from scratch, click the refresh button (for 
example, if you want to view information regarding an individual web page you must clear out the 
stats page). 
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4. If you wish to view rendering stats that have been collected since the last reset, use the 
information presented. 

5. If you wish to collect information about a single page, reset the stats page. In the site window, go 
to the website or webpage that you are going to collect stats about the renderings it includes.  

Note 
Make several calls to the page so that information about caching and averages can be collected. 

6. We recommended that you export the information in the stats page table to Excel, so that the 
information can be sorted for easier data analysis. To export, right click the table and click Export 
to Microsoft Excel. 

2.3.4 Understanding the Results 

The following stats table has been exported into Excel, sorted by Max. time, and has some of the 
columns hidden: 

 

The following observations can be made from this table: 

 All renderings that have Max time in excess of 100ms need to be investigated to see if 
recommended coding practices have been followed. 

 0's in the From cache column indicate that Rendering (HTML Output) caching has not been 
configured. 

2.3.5 Sitecore Recommendation 

We recommend that renderings have a Max time of < 100ms, and that Rendering (HTML Output) caching 
be enabled and configured. 
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Report Findings 

Record the Results 

Rendering Max times are < 100ms: __YES __NO 

There is several From cache values equal to 0: __YES __NO 

 

Rendering Max times are < 100ms = YES: 

 

OK. No rendering has a Max time > 100ms, per Sitecore recommended practices. 

 

Rendering Max times are < 100ms = NO: 

 

Error. There are renderings with a Max time > 100ms. Sitecore recommended practices are to keep 
rendering Max times less than 100ms. 

 

There are several From cache values equal to 0 = NO: 

 

OK. Rendering (HTML Output) caching has been enabled and configured per Sitecore recommended 
practices. 

 

There are several From cache values equal to 0 = YES: 

 

Error. Rendering (HTML Output) caching is either not enabled, and/or not configured. Sitecore 
recommended practices are to enable and configure Rendering (HTML Output) caching to improve site 
performance. For more information on how to enable and configure the Rendering caching, see the 
Cache Configuration Reference and the Presentation Component Reference manuals 

 

http://sdn.sitecore.net/Reference/Sitecore%206/Cache%20Configuration%20Reference.aspx
http://sdn.sitecore.net/Reference/Sitecore%206/Presentation%20Component%20Reference.aspx
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2.4 Investigating Memory Leaks with the Sitecore Logs 

The Sitecore system provides a series of performance counters that are logged to the Sitecore log file(s) 
on a ten-minute interval: 

 Process\Private Bytes 

 Process\Virtual Bytes 

 Process\Page File Bytes 

 .net CLR Memory\# Bytes in all Heaps 

 .net CLR Memory\% Time in GC 

 .net CLR Memory\Large Object Heap size 

 .net CLR Loading\Bytes in Loader Heap 

 .net CLR Loading\Current Assemblies 

If the Sitecore performance counters are not available, they can be downloaded from: 

http://sdn.sitecore.net/upload/sdn5/faq/administration/sitecorecounters.zip. 

This article explains possible problems with the counters and solutions for them: 
http://sdn.sitecore.net/Scrapbook/Working%20with%20Sitecore%20Performance%20Counters.aspx 

The two counters that are of interest for this task are the Process\Private Bytes and the .net CLR 
Memory\# Bytes in all Heaps. 

The Process\Private Bytes counter reports all memory that is exclusively allocated for the process 
(w3wp.exe) and can't be shared with other processes on the system. And the .net CLR Memory\# Bytes 
in all Heaps counter reports the combined total size of the Gen0, Gen1, Gen2, and large object heaps. 

Typically the Private Bytes and # Bytes in all Heaps rise and fall at the same rate. If the Private Bytes is 
increasing, but the # Bytes in all Heaps remains stable, unmanaged memory is leaking. If both are 
increasing, and not being cleared, then there is a potential for a leak in the managed memory. 

By using the Sitecore log files, Sitecore Log Analyzer and Excel, we graph these two counters to look for 
potential leaks. 

2.4.1 Required Skills 

 A working knowledge of the Sitecore Logs. 

 A working knowledge of Sitecore Log Analyzer. 

 A working knowledge of graphing with Microsoft Excel. 

2.4.2 Symptoms 

 OutOfMemory Exceptions 

 IIS App Pool recycling 

 Sluggish performance as memory usage increases. 

http://sdn.sitecore.net/upload/sdn5/faq/administration/sitecorecounters.zip
http://sdn.sitecore.net/Scrapbook/Working%20with%20Sitecore%20Performance%20Counters.aspx
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2.4.3 Parsing the Sitecore Log(s) using Sitecore Log Analyzer 

Information about installing and setting up the Sitecore Log Analyzer can be found at 
http://sdn.sitecore.net/Resources/Tools/Log Analyzer.aspx 

This task requires retrieving the values of the necessary health monitor counters from the log files and 
exporting them in CSV file. 

The exported results are opened in Excel so that they can be graphed and compared. 

Getting the values of Process\Private Bytes and # Bytes in all Heaps counters 

The Health Monitor tab of Sitecore Log Analyzer allows you to see and export all health monitor 
counters of the parsed log files in a convenient format. 

 

1. Launch Sitecore Log Analyzer. 

2. Select logs for analyzing. 

3. Click Analyze / Refresh button. 

http://sdn.sitecore.net/Resources/Tools/Log%20Analyzer.aspx
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4. Go to the Health Monitor tab and select necessary counters (Process\Private Bytes and .NET 
CLR Memory\# Bytes in all Heaps). 

 

5. Right click on the table and select Export Table To > CSV File. Save with a meaningful name 
and open the csv file in Excel. 

 

Graphing the Results 

There are several ways to create graphs in Excel. The steps below are for creating a line graph to 
compare the Process\Private Bytes results set to the .net CLR Memory\# Bytes in all Heaps. 
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1. From the Insert tab click Charts / Line / 2D Line 

 

2. In the Data group, click Select Data. If something was selected on the sheet, it attempts to graph 
it. Clear the graph by removing any series and clear the Chart data range. You are presented with 
the Select Data Source dialog box. 

 

3. Click Add. 

4. For the first series, name the series Private Bytes and select the data range from the 
Process\Private Bytes column (column B). 
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5. Next, set the Horizontal (x-axis) labels to the Timestamp column (column A), click Edit and 
selecting column A from sheet 1: 

 

 

6. Click OK. 

 

7. Click Add and do the same for the second series (Bytes in all Heaps), selecting the data range 
from the .net CLR Memory\# Bytes in all Heaps column (column C). Note, that you do not need to 
set the Horizontal (x-axis) labels again. 
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8. Click OK. 

2.4.4 Understanding the Results (Graph) 

 

Graph 1 

 This graph illustrates an example of a memory leak in the managed memory space. The five big 
dips represent app pool restarts due to either the app pool private memory limit being reached, or 
OOM exceptions. Between each dip you can see Private bytes and Heap bytes trending an 
increase in parallel. This is the symptom of a memory leak.  

 Looking at our sample, we can see that both the Private Bytes and the Bytes in all Heaps are 
rising and falling at the same rate. It is OK for memory to raise to a stable point and remain there. 
Note however that our sample graph shows 5 events where memory is reset. Further 
investigation is explained later. 

 If Private Bytes were rising, while Bytes in all Heaps were to remain constant, this would be an 
indication that there is a potential leak in the unmanaged memory space and further investigation 
would be required. 
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 Peaks indicate memory allocation. Moving the mouse over a peak provides information about the 
amount of memory allocated, as well as the time of the event: 

 

Graph 2 

 Detail view of Private Bytes spike, indicating peak memory usage prior to an app pool recycle or 
OOM exception.  
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 Valleys indicate when a garbage collection event has occurred. Moving the mouse over a valley 
provides information as to the memory still allocated, as well as the time that the event occurred:  

 

Graph 3 

 Details of a valley or GC event. Note, this is not an app pool recycle or OOM exception, but the 
normal activity of the garbage collector. 

 By looking at the highest peaks and the lowest valleys, we can use this information to correlate 
information that we can obtain from the Windows event logs. 
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 The high points, just prior to the memory being reset can be compared to the private memory limit 
set for the App Pool (Go to the IIS Manager, select the appropriate App Pool, and select 
Advanced Settings). Please note: If there is no value set for the Private Memory limit on the App 
Pool, check the Sitecore logs for OutOfMemory Exceptions occurring during the same time frame. 
(Below, we can see that the App Pool is set to reset when memory reaches 1800000KB). 

 

 

Graph 4 

 Details of a memory spike just prior to an app pool recycle or OOM exception. This information 
can be used to determine if the memory usage exceeds that of the available memory for the app 
pool. 

 By comparing the low point that follows the peak with information from the Windows event logs, 
we can see that an App Pool recycle did indeed take place. This constant increase in both Private 
Bytes and Bytes in all Heaps, followed by exceeding the memory limits set and a recycling of the 
App Pool could be a potential leak in the managed memory space. Further investigation would be 
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required. 

 

Graph 5 

 Details of a memory reset event. The date and time available can be used to correlate the 
information available from the Sitecore Logs and the Windows Event Logs to see if an OOM 
exception and / or an app pool recycling event has taken place. 

 

(The time stamps match, indicating that the App Pool recycled.) 
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2.4.5 Notes 

Additional information about .net memory usage and leak investigation can be found at: 

 http://msdn.microsoft.com/en-us/magazine/cc163491.aspx 

 http://msdn.microsoft.com/en-us/library/Ee817660(pandp.10).aspx  

http://msdn.microsoft.com/en-us/magazine/cc163491.aspx
http://msdn.microsoft.com/en-us/library/Ee817660(pandp.10).aspx

